
Experimentos com BitTorrent 

1. Antes de começar: preparando o ambiente 

O objetivo deste experimento é duplo: (1) entender o mecanismo de compartilhamento distribuído de 

arquivos do BitTorrent, que tem como foco a disponibilidade de dados na rede; e (2) analisar o 

mecanismo interno de verificação de integridade de dados utilizado pelo BitTorrent. 

Antes de começar, você precisa obter dois aplicativos para realizar o experimento: 

 qBitTorrent: um aplicativo de código fonte aberto para download e criação de arquivos usando 

protocolo BitTorrent. É necessária a instalação do programa no seu computador para realizar os 

experimentos propostos. Disponível: https://www.qbittorrent.org/download.php  

o Obs.: há alternativas na Internet, mas como o qBitTorrent tem código fonte aberto e é 

bastante estável, ele foi a opção escolhida para os experimentos aqui realizados. 

 

 Torrent File Editor: uma ferramenta de código aberto para editar arquivos .torrent. A 

ferramenta ainda é experimental, então algumas funcionalidades não estão totalmente estáveis, 

mas ela será útil para visualizar os hashes listados dentro do arquivo .torrent. Nenhuma 

instalação é necessária: basta executar o aplicativo depois de fazer o download. Disponível: 

https://sourceforge.net/projects/torrent-file-editor/  

 

2. Fazendo download via BitTorrent: arquivos .torrent 
 

Vamos começar fazendo o download de um arquivo via torrent. Em geral, para achar um arquivo ARQ 

com download disponível via torrent basta buscar por [ARQ torrent] em um site de busca (e.g., Google), 

mas para padronizar o experimento vamos fazer o download de um arquivo específico: o sistema 

operacional Ubuntu. Para isso, visite a seguinte URL: 

https://www.ubuntu.com/download/alternative-downloads 

Nesse página, você vai encontrar alguns links para download do Ubuntu na seção “BitTorrent” (veja 

Figura 1). Escolha uma das versões disponíveis, clique com o botão direito do mouse no link 

correspondente, e salve o arquivo .torrent no seu computador. Na prática, você poderia simplesmente 

clicar com o botão esquerdo que o qBitTorrent comumente já seria aberto para fazer o download; 

porém, mas como queremos analisar o arquivo .torrent em si, melhor salvá-lo em um local específico 

para facilitar essa análise posterior. 

https://www.qbittorrent.org/download.php
https://sourceforge.net/projects/torrent-file-editor/
https://www.ubuntu.com/download/alternative-downloads


 

Figura 1 - Página de download do Ubuntu via BitTorrent 

 

Agora, abra o arquivo .torrent obtido com o qBitTorrent. Para isso basta fazer um duplo-clique nesse 

arquivo, arrastá-lo para dentro do qBitTorrent, ou usar a opção “File => Add Torrent File” (“Arquivo => 

Adicionar Arquivo Torrent”) do aplicativo. Qualquer que seja o método escolhido, deve aparecer uma 

caixa de diálogo semelhante à mostrada na Figura 2 (obs.: essa caixa de diálogo não aparece se em 

algum momento você tiver marcado a opção “Never show again” – “Não mostrar novamente”). Perceba 

que o qBitTorrent informa o tamanho do arquivo (no caso, 1.86 GiB) e também o valor de seu hash 

criptográfico (5a8ce26e8a19a877d8ccc927fcc18e34e1f5ff67). Ele também te dá a opção de escolher o 

local onde deseja salvar o arquivo (na Figura 2, o local é “C:\Users\mjunior\Downloads”). Não é 

necessário alterar as outras configurações, então por ora deixe como elas com os valores padrão.  



 

Figura 2 - Abrindo arquivo .torrent com o qBitTorrent 

 

Após clicar no botão “OK”. Você deve ser levado a uma tela de gerenciamento do qBitTorrent similar à 

mostrada na Figura 3. Essa tela mostra os detalhes do download, como a percentagem do arquivo já 

obtida (campo “Done”), o número de seeders (“Seeds”) e leechers (“Peers”) que estão colaborando na 

distribuição do arquivo, a velocidade de download (“Down Speed”) e de upload (“Up speed”), e também 

o tempo estimado para a finalização do download (“ETA”).  



 

Figura 3 - Download via BitTorrent: pedaços obtidos 

 

Ao clicar no botão “General” (“Geral”) no canto inferior esquerdo da tela, é possível também ver quais 

pedaços do arquivo já foram obtidos. Como o BitTorrent segue a política do “mais raros primeiro”, é 

comum que alguns pedaços no meio do arquivo sejam obtidos antes de pedaços no começo ou no fim 

dele: é tudo uma questão de disponibilidade dos pedaços na rede, dando-se preferência aos pedaços 

com menor disponibilidade. Ainda nesta tela, no campo “Information” (“Informações”), você pode obter 

alguns dados adicionais sobre o arquivo em questão: veja que o item “Pieces” (“Pedaços”), em destaque 

na Figura 3, está preenchido com 3814 x 512.0 KiB (have 246), o que significa que o número exato de 

pedaços que compõem o arquivo é 3814, o tamanho de cada um deles é 512 KiB e que já foram obtidos 

246 desses pedaços até o momento. 

Clique agora no botão “Trackers”, também encontrado canto inferior do aplicativo. A tela mostrada 

deve ser similar à da Figura 4: nela podem ser observados os mecanismos usados para que você consiga 

encontrar nós na rede que têm pedaços do arquivo sendo obtido. Pode-se ver que a maioria dos nós 

foram obtidos por meio do tracker “torrent.ubuntu.com/6969”, embora métodos alternativos como 

DHT (que dispensa um servidor), PEX (que consiste em trocar informações diretamente com outros nós) 

e LSD (uma espécie de busca na rede local) também sejam usados.  



 

Figura 4 - Download via BitTorrent: trackers 

 

Finalmente, clique no botão “Peers”, também encontrado canto inferior do aplicativo. A tela mostrada 

deve ser similar à da Figura 5. Nela, podem ser vistos os usuários que estão compartilhando o arquivo 

com você, incluindo informações como: o seu país de origem (observe as diversas bandeiras), seu 

endereço IP, a porta de comunicação, o aplicativo sendo utilizado (e.g., qBitTorrent, Deluge, uTorrent, 

entre outros) e qual a percentagem do arquivo cada um deles tem. Note que, como o Ubuntu é um 

arquivo bastante popular, diversos nós têm 100% dele, i.e., atuam como seeders. 

 



 

Figura 5 - Download via BitTorrent: usuários compartilhando o conteúdo (peers) 

 

3. Fazendo download via BitTorrent: links magnéticos 
 

O qBitTorrent também permite o download do próprio arquivo torrent via links magnéticos. Conforme 

explicado em aula, isso é feito por meio de uma Tabela de Hash Distribuída (Distributed Hash Table – 

DHT).  

Para ver como isso funciona na prática, vamos obter o link magnético relativo à versão do Ubuntu que 

estávamos baixando anteriormente. Isso pode ser feito simplesmente clicando com o botão direito no 

download ativo do Ubuntu, na própria interface do qBitTorrent, e selecionando a opção “Copy Magnetic 

Link” (“copiar link magnético”), conforme ilustrado na Figura 6. Isso copia o link magnético para a área 

de transferência, o que significa que agora você pode usar a opção “colar” (e.g., por meio do atalho 

Ctrl+V) no editor de texto de sua preferência para ver que o link magnético criado é algo parecido com:  

magnet:?xt=urn:btih:5a8ce26e8a19a877d8ccc927fcc18e34e1f5ff67&dn=ubuntu-18.10-desktop-

amd64.iso&tr=http%3a%2f%2ftorrent.ubuntu.com%3a6969%2fannounce&tr=http%3a%2f%2fipv6.to

rrent.ubuntu.com%3a6969%2fannounce 



 

Figura 6 – Obtendo o link magnético para um arquivo .torrent no qBittorrent: opção no “Copy magnet link” no final do menu 

 

Agora, vamos abrir esse link magnético para ver o que acontece. Para isso, primeiro remova a tarefa de 

download sendo feita pelo qBittorrent do  Ubuntu, selecionando-a e clicando em Delete (se preferir, 

você também pode dar um clique direito na tarefa e selecionar a opção “Delete”). Deve aparecer uma 

tela de confirmação da remoção, semelhante à mostrada na Figura 7. Nessa tela, simplesmente clique 

em OK: não é necessário marcar a caixa de seleção “Also delete the files on the hard disk” (“também 

remova os arquivos no disco rígido”), pois vamos retomar a tarefa de download logo em seguida, mas 

desta vez usando o link magnético em vez do arquivo .torrent diretamente. 

 

Figura 7 – Confirmando a remoção de uma tarefa de download no qBittorrent. 



Agora, vamos abrir o link magnético. Para isso, volte à interface do qBittorrent e clique em “File => Add 

Torrent Link” (“Arquivo => Adicionar Link para Torrent”). Deve ser aberta uma caixa de diálogo 

semelhante à mostrada no detalhe da Figura 8. Nessa tela, cole o link magnético obtido anteriormente, 

e clique no botão “Download”.  

 

Figura 8 - Abrindo um link magnético no qBittorrent. 

 

Com isso, deve ser aberta uma nova tela, similar à mostrada na Figura 9. No canto inferior esquerdo 

dessa tela, perceba que há uma mensagem “Retrieving metadata” (“obtendo metadados”), e que não 

há informação alguma sobre o arquivo em questão. O que está acontecendo é que o qBitTorrent está 

fazendo uma busca na DHT do BitTorrent, tentando encontrar o arquivo .torrent referenciado por esse 

link magnético. 



 

Figura 9 – Buscando um arquivo .torrent a partir de seu link magnético. 

 

Depois de algum (normalmente curto) intervalo de tempo, a tela mostrada da Figura 9 deve ser 

substituída por outra muito semelhante à da Figura 2, vista anteriormente quando fizemos o download 

usando o arquivo .torrent diretamente. Isso indica que o qBittorrent conseguiu encontrar o 

arquivo .torrent, mesmo sem contatar um servidor para isso: bastou contar com a ajuda da rede DHT, 

formada por usuários finais fazendo parte do BitTorrent.  

Se você foi bastante atento e é uma pessoa cética, pode até não acreditar nessa “mágica” da DHT 

porque, afinal de contas, o link magnético utilizado incluía o endereço de dois trackers (servidores):  

“http://torrent.ubuntu.com:6969/announce” e “http://ipv6.torrent.ubuntu.com:6969/announce”. 

Entretanto, e embora de fato trackers possam ajudar na busca por informações na rede, neste caso não 

houve trapaça e podemos provar: em vez do link magnético inteiro fornecido pelo qBittorrent, use 

apenas a parte do link que não inclui os trackers (i.e., informações que vêm depois de “&tr=”). No nosso 

exemplo, isso significa usar o seguinte link magnético:  

magnet:?xt=urn:btih:5a8ce26e8a19a877d8ccc927fcc18e34e1f5ff67&dn=ubuntu-18.10-

desktop-amd64.iso 

Perceba que, ainda assim, o qBitTorrent consegue encontrar o arquivo .torrent correspondente ao 

Ubuntu, e uma tela similar à da Figura 2 é novamente mostrada para que o download possa se iniciar.  



4. Criando um arquivo .torrent para compartilhamento 

Vamos começar criando um arquivo .torrent. Para isso, abra a qBitTorrent e vá em “Tools -> Torrent 

Creator” (“Ferramentas -> Criador de Torrent”), conforme mostrado na Figura 10.  

 

Figura 10 – Interface do qBitTorrent: criação de arquivos torrent. 



A janela que se abre deve ser semelhante àquela mostrada na 

 

Figura 11. Nessa janela clique em “Select File” (“Selecionar Arquivo”) selecione um arquivo qualquer, 

como por exemplo o próprio instalador do qBitTorrent. Na caixa de texto “Tracker URLs“, coloque alguns 

endereços de trackers (rastreadores) que você gostaria que ajudassem na distribuição do seu arquivo. 

Existem várias listas na Internet de trackers funcionando atualmente, mas vamos usar a seguinte lista 

para facilitar: 

udp://tracker.opentrackr.org:1337/announce 
http://tracker.internetwarriors.net:1337/announce 
udp://tracker.coppersurfer.tk:6969/announce  
udp://tracker.leechers-paradise.org:6969/announce  
http://explodie.org:6969/announce 

 



Marque também a opção “Start seeding immediately”, para se disponibilizar como seeder do arquivo, e 

escreva alguma descrição na caixa de texto “comments”, para dizer do que se trata o arquivo.  

Você também pode controlar o tamanho dos pedaços nos quais o seu arquivo será quebrado (opção 

“Piece Size”), entre outra configurações. Como isso não será necessário neste experimento, entretanto, 

você pode deixar as opções padrão. Ao finalizar, clique no botão “Create Torrent” (“Criar Torrent”) e 

salve o arquivo em uma pasta qualquer.  

 

 

Figura 11 – Interface de criação de arquivo .torrent no qBitTorrent. 

 



Pronto, você criou o arquivo torrent que está pronto para ser disponibilizado para que terceiros 

consigam fazer o download do seu arquivo! Perceba que o qBitTorrent já iniciou a tarefa de distribuição, 

ativando o compartilhamento do arquivo na sua tela principal conforme ilustrado na Figura 12.  

 

Figura 12 – Atuando como seeder para o arquivo .torrent criado. 

5. Visualizado o conteúdo de um arquivo .torrent  

Agora, vamos verificar o conteúdo de arquivos .torrent usando outro aplicativo, o Torrent File Editor. 

Para isso, abra o arquivo com extensão .torrent obtido anteriormente (uma distribuição do Ubuntu) na 

interface do Torrent File Editor. Basta arrastar o arquivo para dentro do aplicativo, ou então usar o 

botão Open, para que o aplicativo mostre uma tela semelhante à apresentada na Error! Reference 

source not found.. Conforme mostrado nessa figura, é possível observar que há dois trackers listados no 

arquivo .torrent, confirmando o que fora observado com o qBittorrent (veja Figura 4)1:  

                                                           
1
 Obs.: na versão do Torrent File Editor usada (v0.3.13), nem sempre são mostrados todos os trackers listados em 

arquivos .torrent. No caso do arquivo utilizado nos testes desta seção, entretanto, os trackers são mostrados 
corretamente. 



http://torrent.ubuntu.com:6969/announce 
http://ipv6.torrent.ubuntu.com:6969/announce 

Mais uma vez, também é possível observar o tamanho dos pedaços que compõem o arquivo (“Piece 

size”: 512 KiB), e o número total de pedaços que precisam ser obtidos para se ter o arquivo completo 

(“Pieces”: 3814). Outra informação importante é o hash do arquivo completo, que é idêntico ao 

mostrado no qBitTorrent (veja Figura 2): 5a8ce26e8a19a877d8ccc927fcc18e34e1f5ff67. Assim como o 

qBittorrent, também é possível obter nesta tela o “Magnet link” correspondente ao arquivo. 

 

 

Figura 13 – Arquivo “ubuntu-18.10-desktop-amd64.iso.torrent” mostrado pelo Torrent File Editor v0.3.13. 

 

Um último ponto interessante de observar (e uma das principais razões por estarmos usando o Torrent 

File Editor neste experimento) é que o arquivo .torrent contém o hash de cada um dos pedaços que 

compõem o arquivo. Para verificar isso, comece abrindo o arquivo .torrent que você criou2 no 

experimento da Seção 4. Em seguida, acesse a aba “Tree” (“árvore”) e expanda os nós “Root” (“raiz”) e 

“Info” (“informações”): basta clicar na seta à esquerda de “Root“ e depois na seta à esquerda de “Info”. 

O resultado deve ser similar ao mostrado na Figura 14.  

                                                           
2
 A razão para essa mudança de arquivo é que a versão do Torrent File Editor usada (v0.3.13) não é muito 

“amigável” com arquivos grandes, como é o caso do Ubuntu: como esse arquivo tem muitos pedaços, as limitações 
da interface do aplicativo o impedem de mostrar os hashes de todos os pedaços.  



 

Figura 14 - Arquivo “qbittorrent_4.1.5_x64_setup.exe.torrent” mostrado pelo Torrent File Editor v0.3.13: acessando os 
hashes dos pedaços que compõem o arquivo. 

 

Agora, para ver os hashes de todos os pedaços do arquivo, dê um duplo clique na coluna “Value” 

(“valor”) do campo “pieces” (“pedaços”), mostrado em destaque na Figura 14, e então copie e cole o 

conteúdo para o editor de texto de sua preferência. Você verá que, embora a interface do Torrent File 

Editor não dê muita noção do tamanho desse campo, ele tem um total de 40*NP caracteres 

hexadecimais, onde NP é o número de pedaços que compõem o arquivo referenciado pelo .torrent. Por 

exemplo, como o arquivo usado no experimento da Figura 14 tem NP=358 pedaços, o número total de 

caracteres hexadecimais no campo “pieces” é 40*358 = 14.320. A razão para isso é que o BitTorrent em 

sua versão atual usa o algoritmo SHA-1 para verificação de integridade, de modo que cada pedaço tem 

um hash de 160 bits (o que equivale a 40 caracteres hexadecimais).  

6. Considerações finais 

Isso conclui o experimento com o protocolo BitTorrent. Como se trata de uma solução aberta, tal 

protocolo pode ser integrado em diversas soluções envolvendo compartilhamento colaborativo de 

arquivos de forma segura. De fato, há sistemas operacionais que fazem isso para distribuir atualizações 

(veja, por exemplo, https://www.theregister.co.uk/2015/07/31/windows_10_torrent_updates/), o que 

mostra a grande flexibilidade e interesse do BitTorrent. 

https://www.theregister.co.uk/2015/07/31/windows_10_torrent_updates/

